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STEP 1 – INSTALLING PAYROLL 2019 

 
You can download CollSoft Payroll 2019 from our website https://www.collsoft.ie by clicking into the 
“Downloads” section and selecting the 2019 download. 
 
Depending on your internet browser you may be asked where you would like to save the Payroll 2019 
installer, or it may just be downloaded directly to your “Downloads” folder. 
 
Once the installer has been downloaded simply browse to the location where it is saved and double click on 
it to start the installation process. 
 
Note: Depending on your PCs setup, you may need to contact your network administrator to install Payroll 
2019. 
 
The process of installing the 2019 software is straightforward, simply follow the instructions on the 
Installation Wizard. 
 
At the end of the installation process it is advisable to restart your PC in order to ensure that all components 
are installed correctly. This is particularly important as Payroll 2019 includes some new components required 
to enable PAYE Modernisation integration. 
  

https://www.collsoft.ie/
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STEP 2 - IMPORT YOUR DATA FROM PAYROLL 2018 
 

If you used CollSoft Payroll in 2018, you can import your company listing and the employee records directly 

from 2018 into 2019 to start the 2019 tax year. You can also import your data using a backup created from 

your 2018 system. 

 

Importing your data directly from Payroll 2018 
 

Open Payroll 2019 and from the “File” menu select the “Import CollSoft Payroll 2018 Data…” then “From 
Payroll 2018” option. 

 

Alternatively, you can select the “Import From CollSoft Payroll 2018” option in the sidebar menu on the 
main Company List screen. 
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Next, select the companies that you would like to import; 
 

 
 

Note: If you were running Payroll 2018 using the “Run As Administrator” option but you are not doing so 

with Payroll 2019 then you may not see your list of companies as expected. This is because Windows stores 

data for different users in different folders, so you must ensure that you are running Payroll 2019 in the 

same user context that you used to run Payroll 2018. 

You can import companies individually or in batches, and you can always leave certain companies to be 

imported later. Simply select the companies that you wish to import now and press the “Import” button. 

Payroll 2019 will then begin the process of transferring the selected data from 2018 into 2019. 

 

On completion the total number of companies imported will confirm on screen. 
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Tasks to perform after Importing 2018 Data 
 

With PAYE Modernisation you are no longer able to carry forward employees P2C tax information, so each 

employee will initially be set up on an Emergency tax basis in 2019. You will be able to update their tax 

information by downloading their 2019 RPNs from Revenue as described in Step 4 later. 

Additionally there are two new items of employee data that you may need to update on your employee 

records; 

1. Director Status 

2. PRSI Exemption Reason 

Payroll 2019 will automatically classify all Class S employees as being “Proprietary” directors, however you 

should ensure that this is correct, and that all other classes of Directors are correctly identified. 

This setting can be found on the “Personal” tab of the “Employee Details” screen. 

 

It is important that you identify your directors correctly as failure to do so may result in the loss of the 

“Earned Income Tax Credit” or “Employee Tax Credit” in a subsequent RPN. 

Likewise, if any of your employees are categorised as being PRSI Exempt then you must also specify the 

reason why they are exempted by setting the “Exemption Reason” in the “PRSI” section of their “Employee 

Details” screen; 

 



 
 

10 Step Guide to Payroll 2019 CollSoft Payroll 2019 Page 6 of 29 

 

 

Again, it is important that these settings are correctly set as they are included in your Payroll Submissions to 

Revenue.  

 

Importing your Data from a 2018 backup 

 
Payroll 2019 can also import your data from a backup that was created in the 2018 software. The process is 
very similar to the one for importing your data directly from 2018 and can be performed as follows; 
 
Open Payroll 2019 and from the “File” menu select the “Import CollSoft Payroll 2018 Data…” then “From 
Backup” option. 
 

 
 
Using the “Select Backup File” dialog screen, browse to and select the 2018 backup that you would like to 
import from. 

 
 
From here the process is exactly the same as the direct import process described earlier. 
 
Again, please ensure that you correctly identify any directors and provide an “Exemption Reason” for all 
employees who are marked as exempt from PRSI. 
  



 
 

10 Step Guide to Payroll 2019 CollSoft Payroll 2019 Page 7 of 29 

 

STEP 3 - INSTALL YOUR ROS DIGITAL CERTIFICATE 
 

Payroll 2019 has the capability to interface directly with the ROS PAYE Modernisation web services enabling 

you to download your employee’s RPNs directly into the software, and to file your Payroll Submissions with 

Revenue directly from your payroll software. 

This direct reporting functionality is achieved using your existing ROS Digital Certificate which must be 

imported into Payroll 2019. 

The process of importing and validating your ROS Digital Certificate is straight forward and only needs to be 

performed once. 

The first thing that you need to do is to create a backup copy of your existing ROS Digital Certificate as 

follows; 

• Go to the ROS Login screen and click ‘Manage My Certificates’. 

 

• You will now be shown the Certificate Management screen where you will see a list of “Certificates 

already loaded in this browser”. Locate the certificate that you wish to use in Payroll 2019 and press 

the “Save” icon as shown below; 
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The “Save Certificate” dialog screen will now appear. Press the “Save” button to save a copy of your 

ROS Certificate on your PC. 

 

 
 

Depending on your browser you may be asked where you would like to save your certificate, or it 

may just be saved in your “Downloads” folder. 

 

The next step is to import this ROS Digital Certificate into your Payroll 2019 software. Open Payroll 

2019 and log into one of your companies. 
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On the toolbar at the top of your screen press the “Certs” button 

 

 
 

This will open the Certificate Management Screen.  

 

 
 

Press the “Load Certificate” button to start the ROS Digital Certificate Import Wizard and press 

“Next” 
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Now, press on the “Open” button to browse to and select the Digital Certificate file that you saved from ROS 

previously, enter your ROS password and press “Next” 

 

 
 

You will now be asked to specify what type of certificate you are importing – A regular Employer 

certificate or a Tax Agent certificate. 

 

Most users will have regular Employer certificates. If you are using a Tax Agent Certificate then you 

will need to enter your TAIN also. 

 

 
 

Press the “Finish” button to import your certificate. 
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After your certificate has been imported into Payroll 2019 you will be prompted to validate your 

certificate. 

 

This process will check that your ROS digital certificate is valid for use with the Employer by calling 

the ROS web services to validate the certificate against all of the employers set up in your Payroll 

Software. 

 

We recommend that you carry out this validation process to ensure that your ROS certificate is valid 

for use with your employers. 
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STEP 4 – DOWNLOAD YOUR 2019 RPNS 
 
Under the new PAYE Modernisation regulations, employers are no longer allowed to carry forward their 
employee’s tax information from a previous tax year. 
 
The result of this is that when you import your employees into Payroll 2019 they will all be set to be taxed on 
an Emergency basis. 
 
Therefore, it is important that you download your employee’s 2019 RPNs (previously known as P2C) before 
you run any wages to ensure that all calculations are carried out on the correct basis. 
 
Payroll 2019 is able to interface directly with Revenue in order to download your employee’s RPNs, assuming 
that you have installed your ROS Digital Certificate as described in Step 3. 
 
To begin the process click on the new “RPNs” button on the main toolbar as shown below; 
 

 
 
This will open the new “Employee RPN Import” screen; 

 

 
 
You now have the option to import you employee’s RPNs directly “From ROS” or from an RPN file that you 
downloaded from the ROS website (described later). 
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Press the “From ROS” button, select your ROS Certificate and enter your ROS password and press the “OK” 
button 
 
Note: this is the same password that you use to log into ROS through the ROS website. 
 

 
 
Payroll will now download all the RPNs available for that employer from Revenue, match them to your 
employee records based on their PPSN,  and categorise them as follows; 
 

• Employees with new/updated RPNs from Revenue 

• New Employees 

• Unchanged RPNs 
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Employees With New RPNs From Revenue 
 

 
 
For Employees with new RPNs you can double click on them to view the RPN in more detail, and see how it 
compares with the RPN currently on file for that Employee. 
 

 
Details which have changed will be highlighted in red. You should spend some time checking the updated 
RPNs and when you are ready to apply them press the “Update Now” button. 
 
Note: if you do not press the “Update Now” button then even though you have downloaded the RPNs from 
Revenue, the new details will not be applied to your employees files. 
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New Employees 
 
Payroll may have identified that there are new employees listed in the RPNs received from Revenue. These 
may be genuinely new employees whom have not as yet been set up in Payroll 2019, but they also could be 
employees who were employed by you previously and still registered as being employed by you with 
Revenue. 
 
Review the list and select the entries which you would like to create new employee records for, and then 
press the “Create New” button. 
 

 
This will create new employee records for the selected employees in Payroll 2019, but it will only update 
their basic tax details. You will need to complete their employee records to include items like rates of pay, 
holiday entitlements etc. 

 
 

Unchanged RPNs 
 
Finally any employees for whom there are no changes to their RPNs will be listed in the “Unchanged RPNs” 
section 
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RPN File Contents 
 
The “RPN File Contents” section contains the full list of all the RPNs received from Revenue for this employer 
irrespective of whether or not they are updated, unchanged or new employees. 
 
From here you can export the RPNs to a CSV file, or save them as a Revenue RPN file that can be transferred 
to another PC that does not have an internet connection. 
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STEP 5 – CHECK FOR PAYROLL 2019 UPDATES 
 
The previous 4 steps can be regarded as “Once off” tasks that you need to perform in order to get you 
Payroll initially set up. 
 
The remaining tasks are ones that you will be performing on a regular basis as you run your wages in 2019. 
 
The first of these tasks is to check if there are any updates available for Payroll 2019 as CollSoft has planed a 
number of update releases during January and February of 2019 as we roll out additional functionality and 
reports. 
 
The process of checking for updates is straightforward and can be done by selecting the “Check For 
Updates” option in the “Help” menu. 
 

 
 

If there are updates available you will be notified and you can then press the “Download and Install” button 
to update your copy of Payroll 2019 to the latest version. 
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STEP 6 – CREATE YOUR PAYROLL PERIOD 
 
In order to start processing your wages you must first create your “Payroll Period” by clicking on the 
“Wages” button on the main toolbar and selecting the “Begin your First Period” option on the left side of 
the screen. 
 

 
 
This will start the “First Pay Period Wizard” which will help you to determine what your first payroll and 
payment dates are. 
 

 
 
There is a subtle but important difference between your “Payroll Date” and your “Payment Date”. 
 
Your Payroll Date is used to determine what tax credits and cut off points are to be used for cumulative 
calculations by specifying the week number (or month number) up to which credits are calculated. 
 
The Payment Date is the date on which the employee is due to receive their wages. 
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Note: Your Payroll Date and your Payment Date do not have to be the same date, and under PAYE 
Modernisation the Payment Date now has special significance because all employers are now required to file 
their Payroll Submission “On or Before” the payment date. Failure to do so is in breech of the new 
regulations and may incur penalties. 
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STEP 7 – CHECK FOR UPDATED RPNS 
 
With PAYE Modernisation Revenue expect employers to check for any updated RPNs when beginning a 
payroll run, and indeed Payroll Submissions contain details about the RPNs that have been used in 
calculating each employees wages. 
 
It is therefore important that you check for updated RPNs at the beginning of each pay cycle. 
 
The process is very similar to that which you did in Step 4, except that you access it by pressing the “RPNs” 
button on the Wage Listing screen; 
 

 
 
The “Employee RPN Import” screen will now be shown and you can choose to download the RPNs directly 
from ROS or from an RPN file as shown before in Step 4. 
 
The main difference with this RPN Import procedure is that it only requests RPNs for the employees who are 
listed in the current pay period. For example if you have both weekly and monthly paid employees in your 
company, then only your weekly paid employees would be retrieved when running a weekly payroll and vice 
versa. 
 
If there are any employees with updated RPNs then review the changes and press the “Update Now” button 
to apply the updated RPNs to the selected employees. 
 
Again, it is worth stressing how important it is that you check for updated RPNs as you progress through the 
tax year. RPN data is included in your Payroll Submissions so Revenue will be aware of what RPNs you are 
using to run your Payroll and failure to use the correct RPNs may attract a Revenue intervention. 
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STEP 8 – RUN YOUR PAYROLL AS NORMAL 
 
Now that you have checked for and applied any RPN updates you can proceed to run your wages as normal. 
 
While running your first period you should spend some extra time checking the calculated wages as there 
are changes to USC rates and bands, as well as changes to some tax credits, so you can expect most 
employee’s net pay to be different from 2018. 
 
The “Wage Entry” screen and the “View Workings” screen now contain an “RPN” tab which shows the 
details of the RPN used to calculate the payroll for that wage entry; 
 

 

 
With CollSoft Payroll 2019 it is possible to file multiple “Payroll Submissions” for the same payroll period so 
if you process your payrolls in different batches, you can file your separate Payroll Submissions accordingly – 
You just have to ensure that you file the submission “On or Before” the date that your employees receive 
payment. 
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STEP 9 – FILE YOUR PAYROLL SUBMISSION (PSR) WITH REVENUE 
 
From 1 January 2019, you will report payroll information to Revenue at the time you pay your employees by 
filing a return known as a “Payroll Submission Request” or “PSR” for short. 
 
A PSR contains detailed information for the payments that you have made to each employee including items 
like payment date, pay before allowable deductions, pay after allowable deductions, PAYE, PRSI, USC, and 
LPT. It also contains information about the RPN or tax credits and cut off points used in the various tax 
calculations as well as information on benefits in kind and pension deductions. You could view this as being 
like filing a P35 every time you pay your employees. 
 
Your PSR must be reported by you to Revenue on or before the date the employees are paid. 
 
‘Date paid’ in the context of PAYE modernisation is defined as the date on which the funds are made 
available. These dates can be different dependant on how you pay the employee. If you pay the employee 
by: 
 

• Cash -  it is the date the cash is given to the employee 

• Cheque - it will be the date on the cheque 

• Bank Transfer - it is the date which the funds are scheduled to be made available in the individual’s 
bank account.  
 

How can I File my PSR? 
 

There are three methods by which you can file your PSR with Revenue; 

1. Direct Payroll Reporting – allows payroll software to communicate seamlessly with Revenue Online 

System (ROS) and exchange the required information. 

2. ROS Payroll Reporting - allows you to use files created by payroll software and upload these through 

ROS. 

3. Manual ROS Entry – allows you to enter your PSR manually via a form on ROS 

CollSoft Payroll 2019 supports both Direct Payroll Reporting and ROS Payroll Reporting. We would 
recommend that customers use the Direct Payroll Reporting option where at all possible as it enables the 
Payroll Software easily reconcile your payroll submissions with the data held in the Payroll Software 
 
Important Note: Users should decide which method of reporting that they are going to use and stick to that 
method for the whole tax year. Making submissions using a variety of methods may lead to a situation 
where the Payroll Software will not be able to reconcile any submissions that were made outside of the 
Payroll Software. CollSoft recommend that users file their submissions using the Direct Payroll Reporting 
option. 
 
Depending on how you administer process your payroll you may only need to make a single Payroll 
Submission for each payroll period, or you may need to make more than one submission for a pay period. 
 
CollSoft Payroll 2019 allows you to file multiple Payroll Submissions for any particular payroll period, so if 
you process your payroll in batches, you will be able to file your submissions accordingly. 
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In this example we are going to be processing two wages initially and then filing a PSR. Then we will process 
the remaining wages and then file a second PSR for the payroll period  
 

So the first two wages have been processed as normal and are ready to be filed. To begin filing press the 
“PSRs” button on the wages listing screen; 
 

 
 
This will start the “Revenue Payroll Submission Wizard” – press “Next” to continue. 
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The first step of the wizard confirms the Payroll Period and the Submission Number that you are going to 
file. 
 

 
 
Each Payroll Period can have multiple submissions, and Payroll 2019 will automatically increment the 
submission number as you make more submissions for that payroll period. 
 
Press Next to continue to select the payroll that are to be included in the submission. You can opt to exclude 
an employee from a submission, in which case they will be picked up on the next submission that you make. 
 
This screen will also identify if the submission line items are “Original” or “Amended” submissions. Original 
submissions are the first submissions that you make for an employee in that pay period. Any modifications 
that you make after you have submitted an original submission are classified as amendments. 
 

 
Press Next to continue to the submission screen where you can view the totals of PAYE, PRSI, USC and LPT 
that are about to be submitted.  
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You should verify that these totals are correct and if so press the Submit button to begin filing the 
submission with Revenue. 
 

 
 
Payroll will then transmit your Payroll Submission to Revenue and wait for revenue to process your 
submission. 
 
Once Revenue has processed your submission Payroll 2019 will receive an acknowledgement message with a 
unique “Acknowledgement ID” and confirmation of the count of payslips received along with the totals of 
PAYE, PRSI, USC and LPT. 
 

 
 
The relevant employee payslips are then updated and marked as filed and the Payroll Submission process is 
complete. 
 
We will now continue to process the remaining wages and submit our second Payroll Submission for this 
payroll period. 
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The Payroll Submission wizard will now identify this submission as the second submission for this payroll 
period; 
 

 
 

Pressing Next you will see that the submission does not include the employees who were submitted on the 
first payroll submission. 
 

 
In this submission you will see that there is an overall PAYE refund  
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Finally you will see the acknowledgement from Revenue for the submission including the PAYE refund. 

 

 
The process of filing your Payroll Submission is quite straightforward and nothing to worry about. 
 
The most important point to remember is that you must file your submission on or before your employees 
receive their wages – not after! 
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STEP 10 – VERIFY YOUR PAYROLL SUBMISSION 
 
Now that you have filed your Payroll Submission you should verify that your Payroll records match your 
Revenue record. 
 
Payroll 2019 can request the totals of your Payroll Submissions by clicking on the “PSRs” button on the 
toolbar at the top of the main program screen as shown below; 
 

 
 

Payroll will then retrieve the relevant data from Revenue as display it in a spreadsheet format 
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You can now compare the figures from Revenue against the totals on your Payroll Summary Report and 
verify that they match. 
 

 
 
 
 
 
 
 


